A Brief Tour of SAS

SAS is one of the most versatile and comprehensive statistical software packages available today, with data management, analysis, and graphical capabilities. It is great at working with large databases. SAS has many idiosyncrasies and carry-overs from its initial development in a mainframe environment. This document will introduce some of the key concepts for working with data using SAS software.

The SAS Desktop

When you open SAS, you will see the SAS desktop with three main windows:

1. The Editor window
   This is the window where you create, edit, and submit SAS command files. The default editor is the Enhanced Editor, which has a system of color coding to make it easier to edit and troubleshoot command files.

2. The Log window
   This is the window where SAS will echo all of your commands, along with any notes (shown in blue), error messages (shown in red), and warnings (shown in green). The log window is cumulative throughout your session and helps to locate any possible problems with a SAS program.

3. The Explorer window
   Among other things, this window shows the libraries that you have defined. SAS libraries are folders that can contain SAS datasets and catalogs. When you start SAS, you will automatically have the libraries Work, Sasuser, and Sashelp defined, plus Maps, if you have SAS/Maps on your system. You can define other libraries where you wish to store and access datasets, as we will see later. If you accidentally close this window, go to View > Contents Only to reopen it.
Additional Windows

1. The Output window
This window will be behind other windows until you generate some output. The text in this window can be copied and pasted to a word processing program, but it cannot be edited or modified.

2. The SAS/Graph window
This window will not open until you generate graphs using procedures such as Proc Gplot or Proc Univariate.

You can navigate among the SAS windows in this environment. Different menu options are available depending on which window you are using.

Set the current directory
To do this, double-click on the directory location at the bottom of the SAS workspace window. You will be able to browse to the folder to use. This folder will be the default location where SAS command files and raw data files will be read from/written to.
Browse to the folder to use for the current folder, and then click on OK.

Double-click here to change the current directory.
Set Output Type

The default output type for SAS 9.3 is HTML. If you want to have plain text (listing) output in addition (or instead of HTML) then go to Tools > Options > Preferences:

In the window that opens, choose the Results Tab, and then select Create Listing. At this point, you can deselect Create HTML or select a different style of output.
SAS Help

When you first open SAS, you will have the option to open SAS help, by clicking on "Start Guides" in the Window that opens up.

If you close this window you can start SAS help later by going to Help > SAS Help and Documentation.
To get help on statistical procedures, click on the **Contents tab** > **SAS Products** > **SAS/Stat** > **SAS/Stat User's Guide**. A list of all SAS/Stat procedures will come up.

Click on the procedure that you wish to see. Each procedure has an introduction, a syntax guide, information on statistical algorithms, and examples using SAS code. The SAS help tab for the ANOVA procedure is shown below. All help is clickable.
You can also get help by going to the SAS support web page: [http://support.sas.com](http://support.sas.com). Click on Samples & SAS Notes where you can search for help using keywords.

There is also a useful page that gives information on particular statistical topics, listed alphabetically. The url for this page is [http://support.sas.com/kb/30/333.html](http://support.sas.com/kb/30/333.html)
**Getting Datasets into SAS**

Before you can get started with SAS, you will first need either to read in some raw data, or open an existing SAS dataset.

**Reading in raw data in plain text free format**

Here is an excerpt of a raw data file that has each value separated by blanks (free format). The name of the raw data file is class.dat. Missing values are indicated by a period (.), with a blank between periods for contiguous missing values.

Warren F 29 68 139
Kalbfleisch F 35 64 120
Fierce M . . 112
Walker F 22 56 133
Rogers M 45 68 145
Baldwin M 47 72 128
Mims F 48 67 152
Lambini F 36 . 120
Gossert M . 73 139

The SAS data step to read this type of raw data is shown below. The data statement names the data set to be created, and the infile statement indicates the raw data file to be read. The input statement lists the variables to be read in the order in which they appear in the raw data file. No variables can be skipped at the beginning of the variable list, but you may stop reading variables before reaching the end of the list.

```
data class;
  infile "class.dat";
  input lname $ sex $ age height sbp;
run;
```

Note that character variables are followed by a $. Without a $ after a variable name, SAS assumes that the variable is numeric (the default).

Check the SAS log to be sure the dataset was correctly created.

```
data class;
  infile "class.dat";
  input lname $ sex $ age height sbp;
run;
```

NOTE: The infile "class.dat" is:
Filename=C:\Users\kwelch\Desktop\b512\class.dat,
RECFM=V,LRECL=256,File Size (bytes)=286,
Last Modified=05Oct1998:00:44:32,
NOTE: 14 records were read from the infile "class.dat".
The minimum record length was 16.
The maximum record length was 23.
NOTE: The data set WORK.CLASS has 14 observations and 5 variables.
NOTE: DATA statement used (Total process time):
```
   data class;
```

3 infile "class.dat";
4 input lname $ sex $ age height sbp;
5 run;

NOTE: The infile "class.dat" is:
Filename=C:\Users\kwelch\Desktop\b512\class.dat,
RECFM=V,LRECL=256,File Size (bytes)=286,
Last Modified=04Oct1998:23:44:32,
Create Time=10Jan2011:12:56:56

NOTE: 14 records were read from the infile "class.dat".
The minimum record length was 16.
The maximum record length was 23.

NOTE: The data set WORK.CLASS has 14 observations and 5 variables.

Note that SAS automatically looks for the raw data file (class.dat) in the current directory.

This dataset will be saved in the Work library as Work.Class. To check the data, go to the Explorer Window, double-click on the Libraries Icon, then double-click on the Work library, and double-click on Class. It will open in the Viewtable window. To close this view, click on the small X, not the Red X, which will close all of SAS.

You can have the dataset open in the Viewtable window when using it for most SAS procedures, however you cannot sort or modify the data unless you close it first.
You can also get descriptive statistics for the dataset by using the commands shown below:

```sas
proc means data=class;
run;
```

<table>
<thead>
<tr>
<th>Variable</th>
<th>N</th>
<th>Mean</th>
<th>Std Dev</th>
<th>Minimum</th>
<th>Maximum</th>
</tr>
</thead>
<tbody>
<tr>
<td>age</td>
<td>12</td>
<td>36.250</td>
<td>7.829</td>
<td>22.000</td>
<td>48.000</td>
</tr>
<tr>
<td>height</td>
<td>12</td>
<td>67.333</td>
<td>4.812</td>
<td>56.000</td>
<td>73.000</td>
</tr>
<tr>
<td>sbp</td>
<td>14</td>
<td>133.9</td>
<td>11.1</td>
<td>112.000</td>
<td>152.000</td>
</tr>
</tbody>
</table>

Reading in raw data in column format

To read data that are lined up in columns, the input statement is set up by listing each variable followed by the column-range. Character variables are followed by a $, and then the column-range.

Here is an example of a command file to read in raw data from marflt.dat. Proc print is used to print out the first 10 cases of the marflt data set.

```sas
data flights;
   infile "marflt.dat" ;
   input flight 1-3 depart $ 15-17 dest $ 18-20 boarded 34-36;
run;
proc print data=flights(obs=10);
run;
```

Import Data from Excel

If you have 32-bit SAS, you can use the Import Wizard to import Excel files into SAS. if you have 64-bit SAS, you will probably need to type the commands to import the data yourself:

```sas
PROC IMPORT OUT=pulse
   DATAFILE="C:\Users\kwelch\Desktop\LabData\PULSE.XLS"
   DBMS= xls REPLACE;
   SHEET="pulse";
RUN;
```

Temporary SAS datasets

The datasets we have created so far have been temporary. Temporary SAS datasets are saved in the Work library, and can go by their two-level name, e.g., Work.Class, or by a simple one-level name, e.g., Class. These datasets will be lost at the end of the session and must be re-created each time SAS is run.
Create a permanent SAS dataset

To create a permanent SAS dataset, you first need to submit a **Libname** statement to tell SAS where to save the data. A SAS library is an alias for a folder located in Windows. The folder must already exist before it can be referenced in a libname statement.

```sas
libname sasdata2 "C:\Users\kwelch\Desktop\sasdata2";
```

data sasdata2.flights;
  infile "marflt.dat" ;
  input flight 1-3 depart $ 15-17 dest $ 18-20 boarded 34-36;
run;
proc means data=sasdata2.flights(obs=10);
run;

The permanent SAS dataset will be saved in Windows as **flights.sas7bdat** in the folder **C:\Users\kwelch\Desktop\sasdata2**. The file extension (.sas7bdat) is not used in the SAS commands; it is automatically appended to the dataset name by SAS. The **libname** that you use must be 8 characters or less, and must start with a letter or underscore.

Check the Log to be sure the dataset was correctly created.

```sas
22 libname sasdata2 "C:\Users\kwelch\Desktop\sasdata2";
NOTE: Libref SASDATA2 was successfully assigned as follows:
Engine:        V9
  Physical Name: C:\Users\kwelch\Desktop\sasdata2
23 data sasdata2.flights;
24   infile "marflt.dat" ;
25   input flight 1-3 depart $ 15-17 dest $ 18-20 boarded 34-36;
26 run;
NOTE: The infile "marflt.dat" is:
Filename=C:\Users\kwelch\Desktop\b512\marflt.dat,
RECFM=V,LRECL=256,File Size (bytes)=31751,
Last Modified=21Dec1993:06:26:46,
Create Time=10Jan2011:12:56:56
NOTE: Invalid data for boarded in line 420 34-36.
RULE:     ------+-----------2----------3---------4---------5---------6---------7---------8-----
420     87203219013:02LGALAX2,475 283 5321-3  9 0210210 48
flight=872 depart=LGA dest=LAX boarded=. _ERROR_=1 _N_=420
NOTE: Invalid data for boarded in line 548 34-36.
548     92103279017:11LGADFW1,383 282 25012ª 16 5 79180 48
flight=921 depart=LGA dest=DFW boarded=. _ERROR_=1 _N_=548
NOTE: 635 records were read from the infile "marflt.dat".
The minimum record length was 48.
The maximum record length was 48.
NOTE: The data set SASDATA2.FLIGHTS has 635 observations and 4 variables.
```

We note that there were some problems with the raw data when reading in this file, but the dataset was created with 635 observations and 4 variables.
Use permanent SAS datasets created previously

To use a SAS dataset or datasets, you first need to submit a Libname statement pointing to the folder where the dataset(s) are stored.

```
libname sasdata2 "C:\Users\kwelch\Desktop\sasdata2";
```

You should see a note in the SAS log that shows that the library was successfully assigned.

```
libname sasdata2 "C:\Users\kwelch\Desktop\sasdata2";
NOTE: Libref SASDATA2 was successfully assigned as follows:
    Engine:     V9
    Physical Name: C:\Users\kwelch\Desktop\sasdata2
```

Once this library is defined, you can view the datasets in it by going to the Explorer window and clicking on Libraries, and then selecting sasdata2.
NOTE: SAS initialization used:
  real time  10.65 seconds
cpu time   1.43 seconds

libname sasdata2 "C:\Users\kwech\Desktop\sasdata2";
NOTE: Directory for library SASDATA2 contains files of mixed engine types
NOTE: Library SASDATA2 was successfully assigned as follows:
   Engine: V8
   Physical Name: C:\Users\kwech\Desktop\sasdata2

There are 5 libraries defined.

Contents of 'Sasdata2'

Affil  Autism_de...
Autism_soc... Bank
Baseball Business
Business2 Cars
Employee Fitness
To get to the SASDATA2 library if you are already in the WORK library, click in the explorer window, and go up one level to view all the current libraries. Then click on sasdata2 to see all the datasets in that library.

Use an existing Permanent SAS dataset

Once you have defined a library, you can use any dataset in that library. You just need to refer to it using a two-level name. The first part of the name is the library, followed by a dot and the dataset name. For example, you can refer to the Employee dataset by using its two-level name: sasdata2.employee.

Simple descriptive statistics can be obtained by using Proc Means:

```sas
proc means data=sasdata2.employee;
run;
```

<table>
<thead>
<tr>
<th>Variable</th>
<th>Label</th>
<th>N</th>
<th>Mean</th>
<th>Std Dev</th>
<th>Minimum</th>
</tr>
</thead>
<tbody>
<tr>
<td>id</td>
<td>Employee Code</td>
<td>474</td>
<td>237.5000000</td>
<td>136.9762753</td>
<td>1.0000000</td>
</tr>
<tr>
<td>bdate</td>
<td>Date of Birth</td>
<td>473</td>
<td>-1179.56</td>
<td>4302.33</td>
<td>-31282.00</td>
</tr>
<tr>
<td>educ</td>
<td>Educational Level (years)</td>
<td>474</td>
<td>13.4915612</td>
<td>2.8848464</td>
<td>8.00000000</td>
</tr>
</tbody>
</table>
Selecting cases for analysis

You can select cases for an analysis using the `Where` statement in your commands:

```sql
proc print data=sasdata2.employee;
  where jobcat=1;
run;
```

Notice that some of the values of `bdate` are negative, because dates are stored as the number of days from January 1, 1960, with dates prior to this date having negative values. We will see how to make dates look nice later, here we use SAS formats to make the data display look better:

```sql
proc print data=sasdata2.employee;
  where jobcat=1;
  format bdate mmddyy10. salary salbegin dollar12.;
run;
```
Comments in a SAS program

There are two types of comments in a SAS program, which will appear in green in the Enhanced Editor. You can start a comment with an asterisk (*) to comment out a single SAS statement. A semicolon (;) is required to terminate the comment.

*This is an example of a comment;  
**** This is also a valid comment ****;

You can use /* and */ to insert a comment anywhere in your SAS program. This type of comment can be used to comment out whole blocks of code.

;/*This is an example of a comment*/

/**************************************************************************  
 This is also a valid comment                             
**************************************************************************/

Create and modify variables

The SAS Data Step is a powerful and flexible programming tool that is used to create a new SAS dataset.

The Data Step allows you to assign a particular value to all cases, or to a subset of cases; to transform a variable by using a mathematical function, such as the log function; or to create a sum, average, or other summary statistic based on the values of several existing variables within an observation.

NB: A Data Step is required to create any new variables or modify existing variables in SAS. Unlike Stata and SPSS, you cannot simply create a new variable or modify an existing variable in “open” SAS code. You need to create a new dataset by using a Data Step whenever you want to create or modify variables. A single Data Step can be used to create an unlimited number of new variables.

We will illustrate creating new variables using the employee dataset.
The Data Step starts with the **Data** statement and ends with **Run**. Each time you make any changes to the Data Step commands, you must highlight and re-submit the entire block of code, starting with "data" and ending with "run". This will re-create your dataset by over-writing the previous version.

```sas
data sasdata2.employee2;
  set sasdata2.employee;
  /* put commands to create new variables here*/
  /* be sure they go BEFORE the run statement*/
run;
```

The example below illustrates creating a number of new variables in our new dataset.

```sas
data sasdata2.employee2;
  set sasdata2.employee;
  currentyear=2005;
  alpha ="A";

  datevar = mdy(10,5,2012);/*
  datevar = "05OCT2012"D;
  format datevar mmddyy10. ;

  saldiff = salary - salbegin;
  if (salary >= 0 and salary <= 25000) then salcat = "C";
  if (salary > 25000 & salary <= 50000) then salcat = "B";
  if (salary > 50000) then salcat = "A";

  if salary not=. and jobcat not=. then do;
    if (salary < 50000 & jobcat = 3) then manlowsal = 1;
    else manlowsal = 0;
  end;

  format bdate mmddyy10. salary salbegin dollar12. ;

  if gender="f" then female=1;
  if gender="m" then female=0;

  if jobcat not=. then do;
    jobdum1 = (jobcat=1);
    jobdum2 = (jobcat=2);
    jobdum3 = (jobcat=3);
  end;

  nmiss = nmiss(of educ--salbegin);
  salmean = mean(salary, salbegin);
run;
```
Examples of Functions and Operators in SAS

The following list contains some of the more common SAS functions and operators:

**Arithmetic Operators:**
+    Addition
-    Subtraction
*    Multiplication
/    Division
**    Exponentiation

**Arithmetic Functions:**
ABS  Absolute value
INT  Truncate
SQRT Square root
LOG10 Log base 10
SIN  Sine

**Arithmetic Functions:**
ROUND(arg,unit)   Rounds argument to the nearest unit
MOD             Modulus (remainder)

**Statistical Functions (Arguments can be numeric values or variables):**
SUM(Arg1, Arg2,…,ArgN)  Sum of non-missing arguments
MEAN(Arg1, Arg2,…,ArgN) Mean of non-missing arguments
STD(Arg1, Arg2,…,ArgN)  Standard deviation of non-missing arguments
VAR(Arg1, Arg2,…,ArgN)  Variance of non-missing arguments
CV(Arg1, Arg2,…,ArgN)   Coefficient of variation of non-missing arguments
MIN(Arg1, Arg2,…,ArgN)  Minimum of non-missing arguments
MAX(Arg1, Arg2,…,ArgN)  Maximum of non-missing arguments

**Missing Values Functions:**
MISSING(Arg) = 1 if the value of Arg is missing
               = 0 if not missing
NMISS(Var1, Var2,…,VarN)   Number of missing values across variables within a case
N(Var1, Var2,…,VarN)      Number of non-missing values across variables within a case

**Across-case Functions:**
LAG(Var)   Value from previous case
LAGn(Var)  Value from nth previous case

**Date and Time Functions:**
Datepart(datet imevalue) Extracts date portion from a datetime value
Month(datevalue)        Extracts month from a date value
Day(datevalue)          Extracts day from a date value
Year(datevalue)         Extracts year from a date value
Intck(interval',datestart,dateend) Finds the number of completed intervals between two dates

Other Functions:
- RANUNI(Seed) Uniform pseudo-random no. defined on the interval (0,1)
- RANNOR(Seed) Std. Normal pseudo-random no.
- PROBNORM(x) Prob. a std. normal is <= x
- PROBIT(p) p\text{th} quantile from std. normal dist.

Numeric vs. Character Variables

There are only two types of variable in SAS: numeric and character. Numeric variables are the default type and are used for numeric and date values.

Character variables can have alpha-numeric values, which may be any combination of letters, numbers, or other characters. The length of a character variable can be up to 32767 characters. Values of character variables are case-sensitive. For example, the value “Ann Arbor” is different than the value “ANN ARBOR”.

Generating Variables Containing Constants

In the example below we create a new numeric variable named “currentyear”, which has a constant value of 2005 for all observations:

```sas
currentyear=2005;
```

The example below illustrates creating a new character variable named “alpha” which contains the letter “A” for all observations in the dataset. Note that the value must be enclosed either in single or double-quotes, because this is a character variable.

```sas
alpha ="A";
```

Dates can be generated in a number of different ways. For example, we can use the mdy function to create a date value from a month, day, and year value, as shown below:

```sas
datevar = mdy(10,5,2012);
```

Or we can create a date by using a SAS date constant, as shown below:

```sas
datevar = "05OCT2012"D;
```

The D following the quoted date constant tells SAS that this is not a character variable, but a date value, which is stored as a numeric value.

```sas
format datevar mmddyy10.;
```
The format statement tells SAS to display the date as 09/11/2001, rather than as the number of days from January 1, 1960.

### Generating Variables Using Values from Other Variables

We can also generate new variables as a function of existing variables.

```sas
saldiff = salary - salbegin;
```

New variables can be labeled with a descriptive label up to 40 characters long:

```sas
label saldiff = "Current Salary - Beginning Salary";
```

We can use the `mdy` function to create a new date value, based on the values of three variables, in this example the variables were called “Month”, “Day”, and “Year”, although they could have different names:

```sas
date = mdy(month, day, year);
```

Values of the date variable would vary from observation to observation, because the `mdy()` function is using different values of variables to create date. Remember to use a Format statement to format the new variable `DATE` so it will look like a date.

```sas
format date mmddyy10.;
```

### Generating Variables Conditionally Based on Values of Other Variables

You can also create new variables in SAS conditional on the values of other variables. For example, if we wanted to create a new character variable, `SALCAT`, that contains salary categories “A”, “B”, and “C” we could use the following commands.

```sas
if (salary >= 0 and salary <= 25000) then salcat = "C";
if (salary > 25000 and salary <= 50000) then salcat = "B";
if (salary > 50000) then salcat = "A";
```

Note the use of an **If...Then statement** to identify the condition that a given case in the data set must meet for the new variable to be given a value of “A”. In general, these types of conditional commands have the form:

```sas
if (condition) then varname = value;
```

where the condition can be specified using a logical operator or a mnemonic (e.g., = (eq), & (and), | (or), ~= (not=, ne), > (gt), >= (ge) < (lt) <= (le)). The parentheses are not necessary to specify a condition in SAS, but can be used to clarify a statement or to group parts of a statement. A semicolon is required at the end of the statement. For example, if one wants to
create a variable that identifies employees who are managers but have relatively low salaries, one could use a statement like

```
if (salary < 50000 & jobcat = 3) then manlowsal = 1;
```

This will create a new character variable equal to 1 whenever an employee meets the specified conditions on the two variables, salary and jobcat. However, this variable may be incorrectly coded, due to the presence of missing values, as discussed in the note below.

**Note on missing values when conditionally computing new variables in SAS:**

SAS considers missing values for numeric variables to be smaller than the smallest possible numeric value in a data set. Therefore, in the salary condition above, if an employee had missing data on the salary variable, that employee would be coded into category 1 on the new MANLOWSAL variable. A safer version of this conditional command would look like this:

```
if (salary not=. & salary < 50000 & jobcat = 3) then manlowsal = 1;
```

The condition now emphasizes that salary must be less than $50,000 and not equal to a missing value.

The following statements could be used to set up a variable with a value of 1 or 0 on the new variable MANLOWSAL. Note that the use of ‘else’ will put all values, including missing values on either variable, into the 0 category (every other value, including missing, is captured by the ‘else’ condition). The final If statement will put anyone with a missing value on either of these variables into the missing value of MANLOWSAL, which is . for a numeric variable.

```
if (salary not=. & salary < 50000 & jobcat = 3) then manlowsal =1;
else manlowsal = 0;
if salary = . or jobcat= . then manlowsal= .;
```

Another way this could be done would be to use a Do Loop before creating the variable, as shown below. If you use a do; statement, you must have an end; statement to close the do loop. In the example below, the entire block of code will only be executed if salary is not missing and jobcat is not missing.

```
if salary not=. and jobcat not=. then do;
  if (salary < 50000 & jobcat = 3) then manlowsal = 1;
  else manlowsal = 0;
end;
```

**Generating Dummy Variables**

Statistical analyses often require dummy variables, which are also known as indicator variables. Dummy variables take on a value of 1 for certain cases, and 0 for all other cases. A common
example is the creation of a dummy variable to recode, where the value of 1 might identify females, and 0 males.

```
if gender="f" then female=1;
if gender="m" then female=0;
```

If you have a variable with 3 or more categories, you can create a dummy variable for each category, and later in a regression analysis, you would usually choose to include one less dummy variable than there are categories in your model.

```
if jobcat not=. then do;
   jobdum1 = (jobcat=1);
   jobdum2 = (jobcat=2);
   jobdum3 = (jobcat=3);
end;
```

### Using Statistical Functions

You can also use SAS to determine how many missing values are present in a list of variables within an observation, as shown in the example below:

```
nmiss = nmiss(of educ--salbegin);
```

The double dashes (--) indicate a variable list (with variables given in dataset order). Be sure to use “of” when using a variable list like this.

The converse operation is to determine the number of non-missing values there are in a list of variables,

```
npresent = n(of educ--salbegin);
```

Another common operation is to calculate the sum or the mean of the values for several variables and store the results in a new variable. For example, to calculate a new variable, salmean, representing the average of the current and beginning salary, use the following command. Note that you can use a list of variables separated by commas, without including “of” before the list.

```
salmean = mean(salary, salbegin);
```

All missing values for the variables listed will be ignored when computing the mean in this way. The min( ), max( ), and std( ) functions work in a similar way.

### User-Defined Formats (to label the values of variables)

User-defined formats can be used to assign a description to a numeric value (such as 1="Clerical", 2="Custodial", and 3="Manager"), or they can be used to apply a more descriptive label to short character values (such as “f” = “Female” and “m” = “Male”). Applying user-
defined formats in SAS is a two-step process. First, the formats must be defined using Proc Format, and then they must be assigned to the variables. This whole process can be done in a number of different ways. We illustrate how to create temporary formats. Note that a format for a character variable is defined with a $ in front of it (e.g., $sexfmt), while a numeric format is not (e.g., minfmt).

```sas
proc format;
  value jobcats 1="Clerical" 2="Custodial" 3="Manager";
  value $sexfmt "f" = "Female"
       "m" = "Male";
  value minfmt 1="Yes"
                0="No";
run;
```

To use these temporary formats, we can include a Format statement when we run each procedure, as illustrated below. If we were to use another procedure, we would need to repeat the Format statement for that procedure also.

```sas
proc freq data=sasdata2.employee;
  tables jobcat gender minority;
  format jobcat jobcats. gender $sexfmt. minority minfmt.;
run;
```

Note that we use a period after the user-defined format names (jobcats., $sexfmt., and minfmt.) when we apply the formats to the variables. This allows SAS to distinguish between format names and variable names.

<table>
<thead>
<tr>
<th>Employment Category</th>
<th>Cumulative Frequency</th>
<th>Cumulative Percent</th>
</tr>
</thead>
<tbody>
<tr>
<td>jobcat</td>
<td>Frequency</td>
<td>Percent</td>
</tr>
<tr>
<td>Clerical</td>
<td>363</td>
<td>76.58</td>
</tr>
<tr>
<td>Custodial</td>
<td>27</td>
<td>5.70</td>
</tr>
<tr>
<td>Manager</td>
<td>84</td>
<td>17.72</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Gender</th>
<th>Cumulative Frequency</th>
<th>Cumulative Percent</th>
</tr>
</thead>
<tbody>
<tr>
<td>gender</td>
<td>Frequency</td>
<td>Percent</td>
</tr>
<tr>
<td>Female</td>
<td>216</td>
<td>45.57</td>
</tr>
<tr>
<td>Male</td>
<td>258</td>
<td>54.43</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Minority Classification</th>
<th>Cumulative Frequency</th>
<th>Cumulative Percent</th>
</tr>
</thead>
<tbody>
<tr>
<td>minority</td>
<td>Frequency</td>
<td>Percent</td>
</tr>
<tr>
<td>No</td>
<td>370</td>
<td>78.06</td>
</tr>
<tr>
<td>Yes</td>
<td>104</td>
<td>21.94</td>
</tr>
</tbody>
</table>
Permanent Formats

Another way to assign formats so that they will apply to the variables any time they are used is to use a format statement in a data step. This method will assign the formats to the variables at any time they are used in the future for any procedure.

```sas
proc format lib=sasdata2;
   value jobcats 1="Clerical" 2="Custodial" 3="Manager";
   value $sexfmt "f" = "Female"
       "m" = "Male";
   value minfmt 1="Yes"
       0="No";
run;

proc datasets lib=sasdata2;
   modify employee;
   format jobcat jobcats. gender $sexfmt. minority minfmt.;
run;
```

This produces output in the SAS log that shows how the employee dataset in the sasdata2 library has been modified.

```sas
104 proc datasets lib=sasdata2;
   Directory
     Libref     SASDATA2
     Engine     V9
     Physical Name  C:\Users\kwelch\Desktop\sasdata2
     Filename     C:\Users\kwelch\Desktop\sasdata2
     #  Name                  Type         Size  Last Modified
     1  AFIFI                 DATA        50176  08Dec10:11:10:13
     2  AUTISM_DEMOG          DATA        25600  03Mar08:10:42:22
     3  AUTISM_SOCIALIZATION  DATA        41984  24Jul09:06:40:00
     4  BANK                  DATA        46080  13Jan08:19:17:04
     5  BASEBALL              DATA        82944  20Jun02:06:12:32
     6  BUSINESS              DATA        17408  20Aug06:03:05:04
     7  BUSINESS2             DATA        17408  24Sep10:05:20:10
     8  CARS                  DATA        33792  22Aug06:00:03:42
     9  EMPLOYEE              DATA        41984  10Jan11:13:58:24
     10 EBOYEE2               DATA        13312  10Jan11:14:10:12
     11 FITNESS               DATA        9216   06Mar06:09:04:44
     12 FORMATS               CATALOG  17408  10Jan11:14:11:31
     13 IRIS                  DATA        13312  20Jun02:06:12:32
     14 TECIMSEN              DATA        1147904 01Jun05:23:00:04
     15 WAVE1                 DATA        578550 20Jun07:11:11:00
     16 WAVE2                 DATA        492544 20Jun07:11:11:00
     17 WAVE3                 DATA        455680 20Jun07:11:11:00
     modify employee2;
     format jobcat jobcats. gender $sexfmt. minority minfmt.;
     run;
```

To use this dataset with the formats later, you need to use some rather arcane SAS code, shown below:
options nofmterr;
libname sasdata2 "C:\Users\kwelch\Desktop\sasdata2";
options fmtsearch=(work sasdata2);

proc means data=sasdata2.employee2;
  class jobcat;
  var saldiff;
run;

Translation:

options nofmterr;
This statement tells SAS not to produce an error if there is a problem with the formats.

libname sasdata2 "C:\Users\kwelch\Desktop\sasdata2";
This statement defines the library where the formats catalog and the SAS dataset are located.

options fmtsearch=(work sasdata2);
This statement tells SAS where to search for formats to be used with the datasets that are used
in the session. SAS will first search WORK for temporary formats, and then search the formats
catalog in SASDATA2 for permanent formats that have been saved there. If there are formats
that have the same name in the two locations, SAS will use the formats in WORK.

The output from these commands is shown below:

<table>
<thead>
<tr>
<th>Employment Category</th>
<th>N</th>
<th>Obs</th>
<th>N</th>
<th>Mean</th>
<th>Std Dev</th>
<th>Minimum</th>
<th>Maximum</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clerical</td>
<td>363</td>
<td>363</td>
<td>13742.49</td>
<td>5973.77</td>
<td>5550.00</td>
<td>64250.00</td>
<td></td>
</tr>
<tr>
<td>Custodial</td>
<td>27</td>
<td>27</td>
<td>15861.11</td>
<td>2415.31</td>
<td>9300.00</td>
<td>21750.00</td>
<td></td>
</tr>
<tr>
<td>Manager</td>
<td>84</td>
<td>84</td>
<td>33719.94</td>
<td>13424.34</td>
<td>14250.00</td>
<td>76240.00</td>
<td></td>
</tr>
</tbody>
</table>

Sorting data

By default SAS sorts observations in Ascending order, from smallest to largest, with missing
values being the smallest values possible. The example below sorts the dataset with salary= .
coming first, and then the values of salary.

proc sort data=sasdata2.employee2;
  by salary;
run;

To sort by descending order, using the descending option:

proc sort data=sasdata2.employee2;
  by descending salary;
run;
Sort by more than one variable

When sorting by more than one variable, SAS sorts based on values of the first variable, and then it sorts based on the second variable, and so on. By default, SAS will use Ascending order for each variable, unless otherwise specified. In the example below, the data set is first sorted in ascending order of gender, and then within each level of gender, in descending order of salary.

```sas
proc sort data=sasdata2.employee2;
  by gender descending salary;
run;
```

Descriptive Statistics Using SAS

Proc Print

Proc Print has a deceptive name, because nothing is printed when this procedure is invoked, the values of all variables are simply listed in the output. The syntax below will automatically print all variables for all cases in the dataset. The output for this procedure has been truncated, to show only the first 18 cases.

```sas
proc print data=pulse;
run;
```

<table>
<thead>
<tr>
<th>Obs</th>
<th>pulse1</th>
<th>pulse2</th>
<th>ran</th>
<th>smokes</th>
<th>sex</th>
<th>height</th>
<th>weight</th>
<th>activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>64</td>
<td>88</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>66</td>
<td>140</td>
<td>2</td>
</tr>
<tr>
<td>2</td>
<td>58</td>
<td>70</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>72</td>
<td>145</td>
<td>2</td>
</tr>
<tr>
<td>3</td>
<td>62</td>
<td>76</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>73</td>
<td>160</td>
<td>3</td>
</tr>
<tr>
<td>4</td>
<td>66</td>
<td>78</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>73</td>
<td>190</td>
<td>1</td>
</tr>
<tr>
<td>5</td>
<td>64</td>
<td>80</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>69</td>
<td>155</td>
<td>2</td>
</tr>
<tr>
<td>6</td>
<td>74</td>
<td>84</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>73</td>
<td>165</td>
<td>1</td>
</tr>
<tr>
<td>7</td>
<td>84</td>
<td>84</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>72</td>
<td>150</td>
<td>3</td>
</tr>
<tr>
<td>8</td>
<td>68</td>
<td>72</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>74</td>
<td>190</td>
<td>2</td>
</tr>
<tr>
<td>9</td>
<td>62</td>
<td>75</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>72</td>
<td>195</td>
<td>2</td>
</tr>
<tr>
<td>10</td>
<td>76</td>
<td>118</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>71</td>
<td>138</td>
<td>2</td>
</tr>
<tr>
<td>11</td>
<td>90</td>
<td>94</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>74</td>
<td>160</td>
<td>1</td>
</tr>
<tr>
<td>12</td>
<td>80</td>
<td>96</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>72</td>
<td>155</td>
<td>2</td>
</tr>
<tr>
<td>13</td>
<td>92</td>
<td>84</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>70</td>
<td>153</td>
<td>3</td>
</tr>
<tr>
<td>14</td>
<td>68</td>
<td>76</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>67</td>
<td>145</td>
<td>2</td>
</tr>
<tr>
<td>15</td>
<td>60</td>
<td>76</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>71</td>
<td>170</td>
<td>3</td>
</tr>
<tr>
<td>16</td>
<td>62</td>
<td>58</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>72</td>
<td>175</td>
<td>3</td>
</tr>
<tr>
<td>17</td>
<td>66</td>
<td>82</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>69</td>
<td>175</td>
<td>2</td>
</tr>
<tr>
<td>18</td>
<td>70</td>
<td>72</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>73</td>
<td>170</td>
<td>3</td>
</tr>
</tbody>
</table>
To select a portion of the data you can use the \texttt{(obs= \ }) option. To select only some variables, add a \texttt{var} statement.

\begin{verbatim}
proc print data=pulse(obs=6);
 var height weight pulse1 pulse2;
run;
\end{verbatim}

\begin{verbatim}
Obs  height  weight  pulse1  pulse2
 1    66     140     64    88
 2    72     145     58    70
 3    73     160     62    76
 4    73     190     66    78
 5    69     155     64    80
 6    73     165     74    84
\end{verbatim}

\textbf{Proc Contents}

Proc Contents is used to get meta-data about the SAS dataset. It queries the file header and returns information about the dataset.

\begin{verbatim}
proc contents data=pulse;
run;
\end{verbatim}

The \texttt{CONTENTS} Procedure

\begin{verbatim}
Data Set Name       WORK.PULSE      Observations          92
Member Type         DATA           Variables             8
Engine              V9              Indexes               0
Created             Monday, August 26, 2013 04:00:29 PM  Observation Length    64
Last Modified       Monday, August 26, 2013 04:00:29 PM  Deleted Observations 0
Protection          Compressed      NO
Data Set Type       Sorted          NO
Label               Data Representation  WINDOWS_64
Encoding            wlatin1  Western (Windows)
\end{verbatim}

Engine/Host Dependent Information

\begin{verbatim}
Data Set Page Size          8192
Number of Data Set Pages    1
First Data Page             1
Max Obs per Page            127
Obs in First Data Page      92
Number of Data Set Repairs  0
Filename                    C:\Users\kwelch\AppData\Local\Temp\SAS Temporary Files\_TD312_CSCAR-5QP2JS1\_pulse.sas7bdat
Release Created             9.0301M0
Host Created                X64_7PR0
\end{verbatim}
Alphabetic List of Variables and Attributes

<table>
<thead>
<tr>
<th>#</th>
<th>Variable</th>
<th>Type</th>
<th>Len</th>
<th>Format</th>
<th>Label</th>
</tr>
</thead>
<tbody>
<tr>
<td>8</td>
<td>activity</td>
<td>Num</td>
<td>8</td>
<td>BEST12.</td>
<td>activity</td>
</tr>
<tr>
<td>6</td>
<td>height</td>
<td>Num</td>
<td>8</td>
<td>BEST12.</td>
<td>height</td>
</tr>
<tr>
<td>1</td>
<td>pulse1</td>
<td>Num</td>
<td>8</td>
<td>BEST12.</td>
<td>pulse1</td>
</tr>
<tr>
<td>2</td>
<td>pulse2</td>
<td>Num</td>
<td>8</td>
<td>BEST12.</td>
<td>pulse2</td>
</tr>
<tr>
<td>3</td>
<td>ran</td>
<td>Num</td>
<td>8</td>
<td>BEST12.</td>
<td>ran</td>
</tr>
<tr>
<td>5</td>
<td>sex</td>
<td>Num</td>
<td>8</td>
<td>BEST12.</td>
<td>sex</td>
</tr>
<tr>
<td>4</td>
<td>smokes</td>
<td>Num</td>
<td>8</td>
<td>BEST12.</td>
<td>smokes</td>
</tr>
<tr>
<td>7</td>
<td>weight</td>
<td>Num</td>
<td>8</td>
<td>BEST12.</td>
<td>weight</td>
</tr>
</tbody>
</table>

To get the variables in the order they occur in the dataset, use the varnum option.

```plaintext
proc contents data=pulse varnum;
run;
```

Variables in Creation Order

<table>
<thead>
<tr>
<th>#</th>
<th>Variable</th>
<th>Type</th>
<th>Len</th>
<th>Format</th>
<th>Label</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>pulse1</td>
<td>Num</td>
<td>8</td>
<td>BEST12.</td>
<td>pulse1</td>
</tr>
<tr>
<td>2</td>
<td>pulse2</td>
<td>Num</td>
<td>8</td>
<td>BEST12.</td>
<td>pulse2</td>
</tr>
<tr>
<td>3</td>
<td>ran</td>
<td>Num</td>
<td>8</td>
<td>BEST12.</td>
<td>ran</td>
</tr>
<tr>
<td>4</td>
<td>smokes</td>
<td>Num</td>
<td>8</td>
<td>BEST12.</td>
<td>smokes</td>
</tr>
<tr>
<td>5</td>
<td>sex</td>
<td>Num</td>
<td>8</td>
<td>BEST12.</td>
<td>sex</td>
</tr>
<tr>
<td>6</td>
<td>height</td>
<td>Num</td>
<td>8</td>
<td>BEST12.</td>
<td>height</td>
</tr>
<tr>
<td>7</td>
<td>weight</td>
<td>Num</td>
<td>8</td>
<td>BEST12.</td>
<td>weight</td>
</tr>
<tr>
<td>8</td>
<td>activity</td>
<td>Num</td>
<td>8</td>
<td>BEST12.</td>
<td>activity</td>
</tr>
</tbody>
</table>

Proc Means

Proc Means is a good way to get simple descriptive statistics for the numeric variables in a dataset. The first example below shows how to get descriptive statistics for all numeric variables in a dataset:

```plaintext
proc means data=pulse;
run;
```

<table>
<thead>
<tr>
<th>Variable</th>
<th>Label</th>
<th>N</th>
<th>Mean</th>
<th>Std Dev</th>
<th>Minimum</th>
<th>Maximum</th>
</tr>
</thead>
<tbody>
<tr>
<td>pulse1</td>
<td>pulse1</td>
<td>92</td>
<td>72.8695652</td>
<td>11.0087052</td>
<td>48.0000000</td>
<td>100.0000000</td>
</tr>
<tr>
<td>pulse2</td>
<td>pulse2</td>
<td>92</td>
<td>80.0000000</td>
<td>17.0937943</td>
<td>50.0000000</td>
<td>140.0000000</td>
</tr>
<tr>
<td>ran</td>
<td>ran</td>
<td>92</td>
<td>1.6195652</td>
<td>0.4881540</td>
<td>1.0000000</td>
<td>2.0000000</td>
</tr>
<tr>
<td>smokes</td>
<td>smokes</td>
<td>92</td>
<td>1.6956522</td>
<td>0.4626519</td>
<td>1.0000000</td>
<td>2.0000000</td>
</tr>
<tr>
<td>sex</td>
<td>sex</td>
<td>92</td>
<td>1.3804348</td>
<td>0.4881540</td>
<td>1.0000000</td>
<td>2.0000000</td>
</tr>
<tr>
<td>height</td>
<td>height</td>
<td>92</td>
<td>68.7391304</td>
<td>3.6520943</td>
<td>61.0000000</td>
<td>75.0000000</td>
</tr>
<tr>
<td>weight</td>
<td>weight</td>
<td>92</td>
<td>145.1521739</td>
<td>23.7393978</td>
<td>95.0000000</td>
<td>215.0000000</td>
</tr>
<tr>
<td>activity</td>
<td>activity</td>
<td>92</td>
<td>2.1195652</td>
<td>0.5711448</td>
<td>1.0000000</td>
<td>3.0000000</td>
</tr>
</tbody>
</table>
To select variables, use the var statement. Statistics other than the default can also be specified.

\[
\text{proc means data = pulse n mean min max median p25 p75;} \\
\text{var height weight pulse1;} \\
\text{run;}
\]

<table>
<thead>
<tr>
<th>Variable</th>
<th>N</th>
<th>Mean</th>
<th>Minimum</th>
<th>Maximum</th>
<th>Median</th>
<th>25th Pctl</th>
<th>75th Pctl</th>
</tr>
</thead>
<tbody>
<tr>
<td>height</td>
<td>92</td>
<td>68.7391304</td>
<td>61.0000000</td>
<td>75.0000000</td>
<td>69.0000000</td>
<td>66.0000000</td>
<td>72.0000000</td>
</tr>
<tr>
<td>weight</td>
<td>92</td>
<td>145.1521739</td>
<td>95.0000000</td>
<td>215.0000000</td>
<td>145.0000000</td>
<td>125.0000000</td>
<td>156.0000000</td>
</tr>
<tr>
<td>pulse1</td>
<td>92</td>
<td>72.8695652</td>
<td>48.0000000</td>
<td>100.0000000</td>
<td>71.0000000</td>
<td>64.0000000</td>
<td>80.0000000</td>
</tr>
</tbody>
</table>

Descriptive statistics for each level of a categorical variable can be requested by using a Class statement:

\[
\text{proc means data = pulse;} \\
\text{class ran;} \\
\text{run;}
\]

<table>
<thead>
<tr>
<th>ran</th>
<th>N Obs</th>
<th>Variable</th>
<th>Label</th>
<th>N</th>
<th>Mean</th>
<th>Std Dev</th>
<th>Minimum</th>
<th>Maximum</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>35</td>
<td>pulse1</td>
<td>pulse1</td>
<td>35</td>
<td>73.6000000</td>
<td>11.4357540</td>
<td>58.0000000</td>
<td>100.0000000</td>
</tr>
<tr>
<td></td>
<td></td>
<td>pulse2</td>
<td>pulse2</td>
<td>35</td>
<td>92.5142857</td>
<td>18.9432146</td>
<td>58.0000000</td>
<td>140.0000000</td>
</tr>
<tr>
<td></td>
<td></td>
<td>smokes</td>
<td>smokes</td>
<td>35</td>
<td>1.6571429</td>
<td>0.4815940</td>
<td>1.0000000</td>
<td>2.0000000</td>
</tr>
<tr>
<td></td>
<td></td>
<td>sex</td>
<td>sex</td>
<td>35</td>
<td>1.3142857</td>
<td>0.4710082</td>
<td>1.0000000</td>
<td>2.0000000</td>
</tr>
<tr>
<td></td>
<td></td>
<td>height</td>
<td>height</td>
<td>35</td>
<td>69.7714286</td>
<td>3.3701607</td>
<td>61.0000000</td>
<td>75.0000000</td>
</tr>
<tr>
<td></td>
<td></td>
<td>weight</td>
<td>weight</td>
<td>35</td>
<td>151.7142857</td>
<td>22.6281597</td>
<td>112.0000000</td>
<td>195.0000000</td>
</tr>
<tr>
<td></td>
<td></td>
<td>activity</td>
<td>activity</td>
<td>35</td>
<td>2.1142857</td>
<td>0.5297851</td>
<td>1.0000000</td>
<td>3.0000000</td>
</tr>
<tr>
<td>2</td>
<td>57</td>
<td>pulse1</td>
<td>pulse1</td>
<td>57</td>
<td>72.4210526</td>
<td>10.8165669</td>
<td>48.0000000</td>
<td>94.0000000</td>
</tr>
<tr>
<td></td>
<td></td>
<td>pulse2</td>
<td>pulse2</td>
<td>57</td>
<td>72.3157895</td>
<td>9.9483629</td>
<td>50.0000000</td>
<td>94.0000000</td>
</tr>
<tr>
<td></td>
<td></td>
<td>smokes</td>
<td>smokes</td>
<td>57</td>
<td>1.7192982</td>
<td>0.4533363</td>
<td>1.0000000</td>
<td>2.0000000</td>
</tr>
<tr>
<td></td>
<td></td>
<td>sex</td>
<td>sex</td>
<td>57</td>
<td>1.4210526</td>
<td>0.4981168</td>
<td>1.0000000</td>
<td>2.0000000</td>
</tr>
<tr>
<td></td>
<td></td>
<td>height</td>
<td>height</td>
<td>57</td>
<td>68.1052632</td>
<td>3.7017574</td>
<td>62.0000000</td>
<td>75.0000000</td>
</tr>
<tr>
<td></td>
<td></td>
<td>weight</td>
<td>weight</td>
<td>57</td>
<td>141.1228070</td>
<td>23.6952905</td>
<td>95.0000000</td>
<td>215.0000000</td>
</tr>
<tr>
<td></td>
<td></td>
<td>activity</td>
<td>activity</td>
<td>57</td>
<td>2.1228070</td>
<td>0.5997075</td>
<td>1.0000000</td>
<td>3.0000000</td>
</tr>
</tbody>
</table>

More than one variable can be used in the class statement:

\[
\text{options nolabel;} \\
\text{proc means data = pulse;} \\
\text{class ran activity;} \\
\text{run;}
\]
<table>
<thead>
<tr>
<th>ran</th>
<th>activity N Obs</th>
<th>Variable</th>
<th>N</th>
<th>Mean</th>
<th>Std Dev</th>
<th>Minimum</th>
<th>Maximum</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>pulse1</td>
<td>3</td>
<td>76.666667</td>
<td>12.220219</td>
<td>66.00000</td>
<td>90.00000</td>
</tr>
<tr>
<td></td>
<td></td>
<td>pulse2</td>
<td>3</td>
<td>85.333333</td>
<td>8.0829038</td>
<td>78.00000</td>
<td>94.00000</td>
</tr>
<tr>
<td></td>
<td></td>
<td>smokes</td>
<td>3</td>
<td>1.333333</td>
<td>0.5773503</td>
<td>1.00000</td>
<td>2.00000</td>
</tr>
<tr>
<td></td>
<td></td>
<td>sex</td>
<td>3</td>
<td>1.000000</td>
<td>0</td>
<td>1.00000</td>
<td>1.00000</td>
</tr>
<tr>
<td></td>
<td></td>
<td>height</td>
<td>3</td>
<td>73.333333</td>
<td>0.5773503</td>
<td>73.00000</td>
<td>74.00000</td>
</tr>
<tr>
<td></td>
<td></td>
<td>weight</td>
<td>3</td>
<td>171.666667</td>
<td>16.0727513</td>
<td>160.00000</td>
<td>190.00000</td>
</tr>
<tr>
<td>2</td>
<td>25</td>
<td>pulse1</td>
<td>25</td>
<td>73.760000</td>
<td>11.5516233</td>
<td>58.00000</td>
<td>100.00000</td>
</tr>
<tr>
<td></td>
<td></td>
<td>pulse2</td>
<td>25</td>
<td>98.080000</td>
<td>19.0195513</td>
<td>70.00000</td>
<td>140.00000</td>
</tr>
<tr>
<td></td>
<td></td>
<td>smokes</td>
<td>25</td>
<td>1.720000</td>
<td>0.4582576</td>
<td>1.00000</td>
<td>2.00000</td>
</tr>
<tr>
<td></td>
<td></td>
<td>sex</td>
<td>25</td>
<td>1.440000</td>
<td>0.5066228</td>
<td>1.00000</td>
<td>2.00000</td>
</tr>
<tr>
<td></td>
<td></td>
<td>height</td>
<td>25</td>
<td>69.000000</td>
<td>3.4520525</td>
<td>61.00000</td>
<td>75.00000</td>
</tr>
<tr>
<td></td>
<td></td>
<td>weight</td>
<td>25</td>
<td>147.280000</td>
<td>23.8423992</td>
<td>112.00000</td>
<td>195.00000</td>
</tr>
<tr>
<td>3</td>
<td>7</td>
<td>pulse1</td>
<td>7</td>
<td>71.714286</td>
<td>12.1889880</td>
<td>60.00000</td>
<td>92.00000</td>
</tr>
<tr>
<td></td>
<td></td>
<td>pulse2</td>
<td>7</td>
<td>75.714286</td>
<td>8.9761589</td>
<td>58.00000</td>
<td>84.00000</td>
</tr>
<tr>
<td></td>
<td></td>
<td>smokes</td>
<td>7</td>
<td>1.571429</td>
<td>0.5345225</td>
<td>1.00000</td>
<td>2.00000</td>
</tr>
<tr>
<td></td>
<td></td>
<td>sex</td>
<td>7</td>
<td>1.000000</td>
<td>0</td>
<td>1.00000</td>
<td>1.00000</td>
</tr>
<tr>
<td></td>
<td></td>
<td>height</td>
<td>7</td>
<td>71.000000</td>
<td>2.4494917</td>
<td>66.00000</td>
<td>73.00000</td>
</tr>
<tr>
<td></td>
<td></td>
<td>weight</td>
<td>7</td>
<td>159.000000</td>
<td>14.0949163</td>
<td>135.00000</td>
<td>175.00000</td>
</tr>
<tr>
<td>2</td>
<td>7</td>
<td>pulse1</td>
<td>7</td>
<td>76.285714</td>
<td>15.6813508</td>
<td>48.00000</td>
<td>90.00000</td>
</tr>
<tr>
<td></td>
<td></td>
<td>pulse2</td>
<td>7</td>
<td>76.857143</td>
<td>13.9931965</td>
<td>54.00000</td>
<td>92.00000</td>
</tr>
<tr>
<td></td>
<td></td>
<td>smokes</td>
<td>7</td>
<td>1.714286</td>
<td>0.4780914</td>
<td>1.00000</td>
<td>2.00000</td>
</tr>
<tr>
<td></td>
<td></td>
<td>sex</td>
<td>7</td>
<td>1.571429</td>
<td>0.5345225</td>
<td>1.00000</td>
<td>2.00000</td>
</tr>
<tr>
<td></td>
<td></td>
<td>height</td>
<td>7</td>
<td>67.142857</td>
<td>3.6709931</td>
<td>63.00000</td>
<td>74.00000</td>
</tr>
<tr>
<td></td>
<td></td>
<td>weight</td>
<td>7</td>
<td>139.571428</td>
<td>25.6830498</td>
<td>116.00000</td>
<td>190.00000</td>
</tr>
<tr>
<td>2</td>
<td>36</td>
<td>pulse1</td>
<td>36</td>
<td>72.027778</td>
<td>10.6810543</td>
<td>54.00000</td>
<td>94.00000</td>
</tr>
<tr>
<td></td>
<td></td>
<td>pulse2</td>
<td>36</td>
<td>72.166667</td>
<td>9.6968331</td>
<td>50.00000</td>
<td>94.00000</td>
</tr>
<tr>
<td></td>
<td></td>
<td>smokes</td>
<td>36</td>
<td>1.666667</td>
<td>0.4780914</td>
<td>1.00000</td>
<td>2.00000</td>
</tr>
<tr>
<td></td>
<td></td>
<td>sex</td>
<td>36</td>
<td>1.416667</td>
<td>0.5000000</td>
<td>1.00000</td>
<td>2.00000</td>
</tr>
<tr>
<td></td>
<td></td>
<td>height</td>
<td>36</td>
<td>68.000000</td>
<td>3.5777088</td>
<td>62.00000</td>
<td>75.00000</td>
</tr>
<tr>
<td></td>
<td></td>
<td>weight</td>
<td>36</td>
<td>141.305556</td>
<td>24.5982804</td>
<td>102.00000</td>
<td>215.00000</td>
</tr>
<tr>
<td>3</td>
<td>14</td>
<td>pulse1</td>
<td>14</td>
<td>71.500000</td>
<td>8.6000894</td>
<td>58.00000</td>
<td>87.00000</td>
</tr>
<tr>
<td></td>
<td></td>
<td>pulse2</td>
<td>14</td>
<td>70.428571</td>
<td>8.2342090</td>
<td>58.00000</td>
<td>84.00000</td>
</tr>
<tr>
<td></td>
<td></td>
<td>smokes</td>
<td>14</td>
<td>1.857143</td>
<td>0.3631365</td>
<td>1.00000</td>
<td>2.00000</td>
</tr>
<tr>
<td></td>
<td></td>
<td>sex</td>
<td>14</td>
<td>1.357143</td>
<td>0.4972452</td>
<td>1.00000</td>
<td>2.00000</td>
</tr>
<tr>
<td></td>
<td></td>
<td>height</td>
<td>14</td>
<td>68.857143</td>
<td>4.1483480</td>
<td>62.00000</td>
<td>75.00000</td>
</tr>
<tr>
<td></td>
<td></td>
<td>weight</td>
<td>14</td>
<td>141.428571</td>
<td>21.9920065</td>
<td>95.00000</td>
<td>180.00000</td>
</tr>
</tbody>
</table>
Oneway Frequencies

Proc Freq is useful for tabulating categorical variables. Oneway frequencies can be gotten for variables by listing them in the tables statement.

```
proc freq data = pulse;
   tables ran activity smokes;
run;
```

<table>
<thead>
<tr>
<th>ran</th>
<th>Frequency</th>
<th>Percent</th>
<th>Cumulative</th>
<th>Cumulative</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>35</td>
<td>38.04</td>
<td>35</td>
<td>38.04</td>
</tr>
<tr>
<td>2</td>
<td>57</td>
<td>61.96</td>
<td>92</td>
<td>100.00</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>activity</th>
<th>Frequency</th>
<th>Percent</th>
<th>Cumulative</th>
<th>Cumulative</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>10</td>
<td>10.87</td>
<td>10</td>
<td>10.87</td>
</tr>
<tr>
<td>2</td>
<td>61</td>
<td>66.30</td>
<td>71</td>
<td>77.17</td>
</tr>
<tr>
<td>3</td>
<td>21</td>
<td>22.83</td>
<td>92</td>
<td>100.00</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>smokes</th>
<th>Frequency</th>
<th>Percent</th>
<th>Cumulative</th>
<th>Cumulative</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>28</td>
<td>30.43</td>
<td>28</td>
<td>30.43</td>
</tr>
<tr>
<td>2</td>
<td>64</td>
<td>69.57</td>
<td>92</td>
<td>100.00</td>
</tr>
</tbody>
</table>

Twoway Cross-tabulations

Cross-tabulations can be used to see the frequencies of one variable, conditional on the level of another. In the tables statement, the syntax uses rowvariable * columnvariable as the order.

```
proc freq data=sasdata2.employee2;
   tables gender*jobcat;
run;
```

<table>
<thead>
<tr>
<th>gender (Gender)</th>
<th>jobcat (Employment Category)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frequency</td>
<td>Percent</td>
</tr>
<tr>
<td>----------</td>
<td>---------</td>
</tr>
<tr>
<td>f</td>
<td>206</td>
</tr>
<tr>
<td></td>
<td>43.46</td>
</tr>
<tr>
<td></td>
<td>95.37</td>
</tr>
<tr>
<td></td>
<td>56.75</td>
</tr>
<tr>
<td>m</td>
<td>157</td>
</tr>
<tr>
<td></td>
<td>33.12</td>
</tr>
<tr>
<td></td>
<td>60.85</td>
</tr>
<tr>
<td></td>
<td>43.25</td>
</tr>
<tr>
<td>Total</td>
<td>363</td>
</tr>
</tbody>
</table>

Sample Size = 474
By using different options in the tables statement, you can suppress certain output, and request other output. The tables statement in the SAS code below suppresses all of the percentages from being reported, and requests expected values and chi-square tests for the table.

```
proc freq data = pulse;
   tables sex * activity / expected norow nocol nopercent chisq;
run;
```

Table of sex by activity

<table>
<thead>
<tr>
<th>Frequency</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expected</td>
<td>6.1957</td>
<td>37.793</td>
<td>13.011</td>
<td></td>
</tr>
<tr>
<td></td>
<td>6</td>
<td>35</td>
<td>16</td>
<td>57</td>
</tr>
<tr>
<td></td>
<td>3.8043</td>
<td>23.207</td>
<td>7.9891</td>
<td></td>
</tr>
<tr>
<td></td>
<td>10</td>
<td>61</td>
<td>21</td>
<td>92</td>
</tr>
</tbody>
</table>

Statistics for Table of sex by activity

<table>
<thead>
<tr>
<th>Statistic</th>
<th>DF</th>
<th>Value</th>
<th>Prob</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chi-Square</td>
<td>2</td>
<td>2.3641</td>
<td>0.3067</td>
</tr>
<tr>
<td>Likelihood Ratio Chi-Square</td>
<td>2</td>
<td>2.4827</td>
<td>0.2890</td>
</tr>
<tr>
<td>Mantel-Haenszel Chi-Square</td>
<td>1</td>
<td>1.4339</td>
<td>0.2311</td>
</tr>
<tr>
<td>Phi Coefficient</td>
<td></td>
<td>0.1603</td>
<td></td>
</tr>
<tr>
<td>Contingency Coefficient</td>
<td></td>
<td>0.1583</td>
<td></td>
</tr>
<tr>
<td>Cramer's V</td>
<td></td>
<td>0.1603</td>
<td></td>
</tr>
</tbody>
</table>

Sample Size = 92

If a three-way table is requested, the first variable is a stratification variable, while the actual table is produced by crossing the last two variables.

```
proc freq data = pulse;
   tables ran * sex * activity / expected norow nocol nopercent chisq;
run;
```
Table 1 of sex by activity
Controlling for ran=1

sex       activity

<table>
<thead>
<tr>
<th>Frequency</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Percent</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Row Pct</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Col Pct</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>14</td>
<td>7</td>
<td>24</td>
</tr>
<tr>
<td></td>
<td>8.57</td>
<td>40.00</td>
<td>29.17</td>
<td>68.57</td>
</tr>
<tr>
<td></td>
<td>12.50</td>
<td>56.00</td>
<td>100.00</td>
<td></td>
</tr>
<tr>
<td></td>
<td>100.00</td>
<td>56.00</td>
<td>100.00</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>0</td>
<td>11</td>
<td>0</td>
<td>11</td>
</tr>
<tr>
<td></td>
<td>0.00</td>
<td>31.43</td>
<td>0.00</td>
<td>31.43</td>
</tr>
<tr>
<td></td>
<td>0.00</td>
<td>100.00</td>
<td>0.00</td>
<td></td>
</tr>
<tr>
<td></td>
<td>0.00</td>
<td>44.00</td>
<td>0.00</td>
<td></td>
</tr>
<tr>
<td>Total</td>
<td>3</td>
<td>25</td>
<td>7</td>
<td>35</td>
</tr>
<tr>
<td></td>
<td>8.57</td>
<td>71.43</td>
<td>20.00</td>
<td>100.00</td>
</tr>
</tbody>
</table>

Table 2 of sex by activity
Controlling for ran=2

sex       activity

<table>
<thead>
<tr>
<th>Frequency</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Percent</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Row Pct</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Col Pct</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>21</td>
<td>9</td>
<td>33</td>
</tr>
<tr>
<td></td>
<td>5.26</td>
<td>36.84</td>
<td>27.27</td>
<td>57.89</td>
</tr>
<tr>
<td></td>
<td>9.09</td>
<td>63.64</td>
<td>27.27</td>
<td></td>
</tr>
<tr>
<td></td>
<td>42.86</td>
<td>58.33</td>
<td>64.29</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>4</td>
<td>15</td>
<td>5</td>
<td>24</td>
</tr>
<tr>
<td></td>
<td>7.02</td>
<td>26.32</td>
<td>8.77</td>
<td>42.11</td>
</tr>
<tr>
<td></td>
<td>16.67</td>
<td>62.50</td>
<td>20.83</td>
<td></td>
</tr>
<tr>
<td></td>
<td>57.14</td>
<td>41.67</td>
<td>35.71</td>
<td></td>
</tr>
<tr>
<td>Total</td>
<td>7</td>
<td>36</td>
<td>14</td>
<td>57</td>
</tr>
<tr>
<td></td>
<td>12.28</td>
<td>63.16</td>
<td>24.56</td>
<td>100.00</td>
</tr>
</tbody>
</table>

**Proc Univariate**

Proc Univariate can be used to get more detailed information about continuous variables. The histogram statement requests a histogram for all variables listed in the var statement.

```
proc univariate data = pulse plot;
  var pulse1;
  histogram;
run;
```
The UNIVARIATE Procedure  
Variable:  pulse1

Moments

<p>| | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>N</td>
<td>92</td>
<td>Sum Weights</td>
<td>92</td>
</tr>
<tr>
<td>Mean</td>
<td>72.8695652</td>
<td>Sum Observations</td>
<td>6704</td>
</tr>
<tr>
<td>Std Deviation</td>
<td>11.0087052</td>
<td>Variance</td>
<td>121.191591</td>
</tr>
<tr>
<td>Skewness</td>
<td>0.39738899</td>
<td>Kurtosis</td>
<td>-0.4424433</td>
</tr>
<tr>
<td>Uncorrected SS</td>
<td>499546</td>
<td>Corrected SS</td>
<td>11028.4348</td>
</tr>
<tr>
<td>Coeff Variation</td>
<td>15.1074117</td>
<td>Std Error Mean</td>
<td>1.14773686</td>
</tr>
</tbody>
</table>

Basic Statistical Measures

<table>
<thead>
<tr>
<th>Location</th>
<th>Variability</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mean</td>
<td>72.86957</td>
</tr>
<tr>
<td>Median</td>
<td>71.00000</td>
</tr>
<tr>
<td>Mode</td>
<td>68.00000</td>
</tr>
<tr>
<td>Std Deviation</td>
<td>11.00871</td>
</tr>
<tr>
<td>Variance</td>
<td>121.19159</td>
</tr>
<tr>
<td>Range</td>
<td>52.00000</td>
</tr>
<tr>
<td>Interquartile Range</td>
<td>16.00000</td>
</tr>
</tbody>
</table>

Tests for Location: Mu0=0

<table>
<thead>
<tr>
<th>Test</th>
<th>-Statistic-</th>
<th>-----p Value-----</th>
</tr>
</thead>
<tbody>
<tr>
<td>Student's t</td>
<td>t</td>
<td>Pr &gt;</td>
</tr>
<tr>
<td>Sign</td>
<td>M</td>
<td>Pr &gt;=</td>
</tr>
<tr>
<td>Signed Rank</td>
<td>S</td>
<td>Pr &gt;=</td>
</tr>
</tbody>
</table>

Quantiles (Definition 5)

<table>
<thead>
<tr>
<th>Quantile</th>
<th>Estimate</th>
</tr>
</thead>
<tbody>
<tr>
<td>100% Max</td>
<td>100</td>
</tr>
<tr>
<td>99%</td>
<td>100</td>
</tr>
<tr>
<td>95%</td>
<td>92</td>
</tr>
<tr>
<td>90%</td>
<td>90</td>
</tr>
<tr>
<td>75% Q3</td>
<td>80</td>
</tr>
<tr>
<td>50% Median</td>
<td>71</td>
</tr>
<tr>
<td>25% Q1</td>
<td>64</td>
</tr>
<tr>
<td>10%</td>
<td>60</td>
</tr>
<tr>
<td>5%</td>
<td>58</td>
</tr>
</tbody>
</table>
A class statement can be used to visualize the distribution of a continuous variable, conditional on the level of a categorical variable, as shown below:

```
proc univariate data = pulse plot;
  class ran;
  var pulse2;
  histogram;
run;
```